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Pikaoppaan sisältö 
Pikaoppaassa kuvataan, Netbeans-työkalulla 
luodaan uusi yksinkertainen Java DB -tietokantaa 
hyödyntävä sovellus. Opas kattaa kaiken aiheeseen 
tarvittavan sisällön; kehitysvälineiden asentamisen, 
koodin kirjoittamisen, ohjelmiston kääntämisen ja 
viimeisenä sovelluksen testaamisen.  
Pikaopas on tarkoitettu henkilöille, joilla on 
perustiedot tietotekniikasta ja ohjelmoinnista. 
Pikaoppaan tarkoituksena ei ole käydä 
yksityiskohtaisesti läpi aihepiirin taustoja tai 
teoriaa. Huomattavasti tarkemmin aihepiirin asioita 
käsitellään Pedacoden verkkokursseilla. Lisätietoja 
verkkokursseista löytyy osoitteesta 
www.pedacode.net. 
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Käyttöoikeus 
Materiaalin kaikki oikeudet omistaa Pedacode Ky.  

Pedacode Ky antaa materiaalin käyttöön seuraavat oikeudet: 

- oikeus tallentaa materiaali digitaalisessa muodossa henkilökohtaiseen 
opiskelukäyttöön tietokoneen muistiin, tietolevykkeelle tai muulle digitaaliselle 
alustalle. 

- oikeus valmistaa materiaalista paperikopioita henkilökohtaiseen opiskelukäyttöön. 

- oikeus kopioida ja levittää materiaalia muuttumattomana ja täydellisenä joko 
digitaalisessa- tai paperimuodossa vapaasti haluamilleen tahoille.  

Materiaalin yksittäisiä osia ei saa kopioida eikä materiaalista tai sen osista saa valmistaa 
uusia muokattuja versioita. Materiaalia ei myöskään saa levittää maksua vastaan.  

 
Lyhyesti: Materiaalia saa käyttää ja levittää vapaasti, mutta materiaalia ei saa alkaa 
myymään, eikä materiaalin osia saa kopioida osaksi muuta materiaalia.  
 

 
 

 
 

 
 

 
 

 

Tekijän yhteystiedot 
Pedacode Ky 
(Y-tunnus: 1891298-0) 
WWW-sivut:  http://www.pedacode.net 

E-Mail:  asiakaspalvelu@pedacode.net 
Postiosoite: Pedacode Ky 

PL 12 
00321 HELSINKI 
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KEHITYSYMPÄRISTÖN PYSTYTTÄMINEN 

Ympäristön pystyttämisen vaiheet 
Tietokantaa hyödyntävän sovelluksen luominen aloitetaan vaadittavien ohjelmistojen 
asentamisella, jotta omalle työasemalle saadaan ympäristö, jossa sovelluksen luominen 
on mahdollista. Kehitysympäristön pystyttäminen tehdään kolmessa vaiheessa: 

1. Lataa ja asenna Java Development Kit (JDK) 
2. Lataa ja asenna Netbeans 5.5 IDE.   

Vaihe 1: Lataa ja asenna Java Development Kit 

Lataa Java Development Kit 

Java Development Kit (JDK) on ohjelmistopaketti, joka sisältää Java-ohjelmoinnissa 
välttämättömät sovellukset. Lataa aluksi uusin JDK-paketti Sunin sivulta osoitteesta 
http://java.sun.com/javase/downloads/index.jsp. Sivulla on useita vaihtoehtoja, valitse 
näistä JDK 6 ja paina Download-painiketta: 

 
Painettuasi Donwload-painiketta saat luettavaksi lisenssiehdot; hyväksymällä ehdot pääse 
sivulle, josta voit valita ladattavan paketin sen mukana, mitä käyttöjärjestelmää käytät. 
Tämän ohjeen esimerkeissä käytetään Windows XP SP2 –käyttöjärjestelmää.  

Kun lataus on valmis, sinulla pitäisi olla omalla työasemallasi asennustiedosto jdk-6-
windows-i586-iftw.exe.  

Asenna Java Development Kit 

Käynnistä JDK:n asennus avaamalla edellä ladattu tiedosto jdk-6-windows-i586-
iftw.exe. Asennus etenee seuraavalla tavalla: 

1. Hyväksy aluksi lisenssiehdot painamalla Accept-painiketta 
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2. Seuraavaksi sinulle aukeaa ikkuna, josta voi valita asennettavat sovellukset. 
JDK:n voi asentaa oletusarvoilla, joten paina Next-painiketta: 

 
3. Asennus käynnistyy ja kestää tämän jälkeen hetken aikaa. Kun asennus on valmis, 

paina Finish-painiketta: 

       
 
Huom! JDK:sta tulee tasaisesti uusia versioita. Tässä ohjeessa on käytetty esimerkkinä 
versioita JDK 1.6.0. Kun luet ohjetta, niin Sun on jo mahdollisesti julkaissut uudemman 
version, esimerkiksi JDK 1.6.0.2 tai 1.6.1. Ohje toimii hyvin myös uudempien versioiden 
kanssa.  

Vaihe 2: Lataa ja asenna Netbeans 5.5 IDE 

Lataa Netbeans 

Java-ohjelmia on mahdollista kirjoittaa periaatteessa yksinkertaisella tekstieditorilla, 
Windowsissa vaikkapa Notepadilla. Usein ohjelmointia helpottaa kuitenkin selvästi 
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jonkin valmiin editorin käyttö. Tässä esimerkissä käytetään Netbeans-
sovelluskehitystyökalua. Netbeans sisältää varsinaisen koodieditorin, erilaiset sovellusten 
paketointiin liittyvä toiminnot sekä sovelluspalvelimen, jolla valmista web-sovellusta 
voidaan testata.  

Lataa Netbeans www-sivulta: http://java.sun.com/javaee/downloads. Sivulla on useita 
valintoja, valitse näistä ”Java EE 5 SDK” –kohdasta ”Download with tools” –painike. 

 
Tämän jälkeen saat hyväksyttäväksi Sunin lisenssiehdot, kun olet hyväksynyt ehdot, 
pääset varsinaiselle lataussivulle. Valitse tältä sivulta asennuspaketti sen mukaan, mitä 
käyttöjärjestelmää käytät. Jos esimerkiksi käytät Windowsia, valitse java-tools-bundle-
windows.exe. 

 

Asenna Netbeans 

Käynnistä Netbeans:n asennus käynnistämällä lataamasi tiedosto java-tools-bundle-
windows.exe. Asennusohjelma valmistelee asennusta jonkin aikaa, jolloin ruudulla näkyy 
seuraava ikkuna: 

 
Varsinainen asennus käynnistyy pienen odottelun jälkeen, kun ruudulle tulee näkyviin 
asennusohjelman ikkuna: 
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Paina Next >, jolloin asennusohjelmaan aukeaa lisenssiehtojen hyväksyminen. Hyväksy 
lisenssiehdot, ja paina jälleen Next >. Tämän jälkeen asennusohjelma pyytää 
valitsemaan JDK-paketin, jota Netbeans käyttää. Valitse aiemmin asentamasi JDK 1.6.0 
(tai uudempi): 
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Paina jälleen Next >, jolloin asennusohjelma kysyy hakemiston, johon Netbeans 
asennetaan. Hakemiston voi antaa olla oletusarvona, jatka painamalla vain Next >.  

 
Tämän jälkeen asennusohjelma kysyy, mitä kaikkia osia asennetaan. Asennusohjelman 
ehdottamiin komponentteihin ei tarvitse tehdä muutoksia, jatka painamalla Next >.  
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Seuraavaksi asennusohjelma kysyy, mitä sovelluspalvelinta käytetään. Tämänkin 
asetuksen voi antaa olla oletusarvona, jatka painamalla Next >.  

 
Seuraavaksi asennusohjelma kysyy asennushakemistoa Java EE 5 SDK:lle, myös tämän 
asetuksen voi jättää oletusarvoksi. Jatka painamalla Next >. 
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Asennusohjelma kysyy tämän jälkeen oletusarvoa asennuksen käyttäjätunnukselle ja 
salasanalle. Voit jättää asetuksen oletusarvoksi, jatka painamalla Next >.  

 
Seuraavaksi vuorossa on sovelluspalvelimen käyttämien porttien asetus, hyväksy 
oletusarvot painamalla Next >.  
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Lopuksi asennusohjelma näyttää ikkunan, josta varsinainen asennus aloitetaan edellä 
annetuin asetuksin. Aloita asennus painamalla Install. 

 
 

Kun asennus on valmis, tulee näkyviin asiasta kertoa ikkuna. Sulje asennusohjelma 
painamalla Finish. Netbeans käynnistyy tämän jälkeen automaattisesti.  
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TIETOKANTAA HYÖDYNTÄVÄN SOVELLUKSEN 
LUOMINEN 

Yksinkertainen tietokantasovellus 
Seuraavassa esitetään, miten Netbeans IDE 5.5 –työkalulla luodaan yksinkertainen 
sovellus, joka ottaa yhteyttä tietokantaan ja hakee sieltä tiettyjä tietoja 

Sovelluksen luomisen vaiheet 
Uusi web-sovellus luodaan Netbeans-työkalulla kolmessa vaiheessa 

1. Luo aluksi tietokantaan uusi taulu ja tauluun muutamia rivejä 
2. Luo uusi projekti Netbeansiin 

3. Kirjoita toteutus Main.java -luokkaan 
4. Testataan ohjelman toiminta ohjelma 

Vaihe 1: Luo tietokantaan uusi taulu ja tauluun rivejä 
Käynnistä Java DB –tietokanta valitsemalla Netbeansissa Tools > Java DB 
Database > Start Java DB Server. 
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Luo tietokantapalvelimelle uusi tietokanta valitsemalla Tools > Java DB Database 
> Create Java DB Database... 

 
Anna tietokannan nimeksi ”Esimerkkitietokanta”, käyttäjätunnukseksi ”test” ja 
salasanaksi ”test”: 
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Siirry tämän jälkeen Netbeansissa vasemman laidan valikossa Runtime-näkymään: 

 
Valitse Databases-kohdasta löytyvä Esimerkkitietokanta ja hiiren oikealla painikkeella 
aukeavasta valikosta Connect... 
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Valitse Esimerkkitietokannan alta löytyvä Tables-kohta ja hiiren oikealla painikkeella 
tästä kohdasta aukeavasta valikosta Create Table...: 

 
Anna uudelle taululle nimi AUTO ja lisää Add Column –painikkeella kentät 
REKISTERINUMERO ja MALLI: 

 
Paina tämän jälkeen OK.  
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Lisää luotuun tauluun testidataa. Valitse AUTO-taulun hiiren oikealla painikkeella  

aukeavasta valikosta Execute Command...: 

 
Netbeansiin aukeaa tämän jälkeen uusi editori, jossa voi suorittaa SQL-käskyjä. Lisää 
tauluun uusi rivi kirjoittamalla aukeavaan editoriin 
Insert into "TEST"."AUTO"  Values ('AAA-123', 'Audi A6');  

Paina tämän jälkeen Run SQL –painiketta: 

 
 
Tietokanta on nyt valmis.  
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Vaihe 2: Luo uusi projekti Netbeansiin 
Aloita uuden projektin luominen valitsemalla Netbeansissa File > New 
Project... 
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Valitse projektin tyypiksi General > Java Application: 

 
 
Paina Next >, jonka jälkeen Netbeans kysyy projektin nimeä. Anna nimeksi 
Tietokantasovellus. Muut asetukset voi jättää oletusarvoiksi: 
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Paina jälkeen Finish, jonka jälkeen uusi projekti tulee näkyviin Netbeans:n vasemman 
laidan näkymään: 
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Lisää projektiin vielä JDBC-ajurit. Valitse hiiren vasemmalla painikkeella projektin 
kohdalta aukeavasta valikosta Properties...: 
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Valitse aukeavasta ikkunasta vasemman laidan näkymästä Libraries-kohta ja paina tämän 
jälkeen ikkunan oikeassa laidassa Add Library... –painiketta. 

 
 

Valitse Add Library –painikkeella avautuvasta ikkunasta Java DB Driver –kirjasto 
ja paina tämän jälkeen Add Library –painiketta: 

 
 

Paina lopuksi vielä edellisessä Properties-ikkunassa OK-painiketta, projekti on tämän 
jälkeen valmis.  
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Vaihe 3: Kirjoita toteutus Main.java-luokalle 
Netbeans luo automaattisesti Main-nimisen luokan ja pohjan luokan koodille. Kirjoita 
Main-luokan main()-metodiin toteutus, joka ottaa yhteyttä tietokantaan, hakee 
tietokannasta löytyvät rivit ja lopuksi tulostaa löytyneet tiedot ruudulle. Ohjelman 
toiminta on kommentoitu tarkemmin alla olevassa koodissa: 
package tietokantasovellus; 
 
import java.sql.PreparedStatement; 
import java.sql.ResultSet; 
import java.util.Properties; 
import java.sql.Connection; 
import java.sql.DriverManager; 
 
/** 
 * Esimerkkisovellus, joka hakee tietoja tietokannasta 
 * @author Pedacode Ky 2007 
 */ 
public class Main { 
     
    /** Creates a new instance of Main */ 
    public Main() { 
    } 
     
    /** 
     * @param args the command line arguments 
     */ 
    public static void main(String[] args) { 
        try { 
             // Vaihe 1: Ladataan JDBC-ajuri 
            String driver = "org.apache.derby.jdbc.ClientDriver"; 
            Class.forName(driver).newInstance(); 
 
            // Vaihe 2: Määritellään yhteyden parametrit 
            Properties props = new Properties(); 
            props.put("user", "test"); 
            props.put("password", "test"); 
 
            // Vaihe 3: Avataan yhteys 
            String url = 
"jdbc:derby://localhost:1527/Esimerkkitietokanta"; 
            Connection conn = DriverManager.getConnection(url, 
props); 
             
            // Vaihe 4: Luodaan PreparedStatement, joka sisältää 
            // tiedot hakevan SQL-kyselyn 
            PreparedStatement s =  
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                    conn.prepareStatement("Select 
REKISTERINUMERO, MALLI from AUTO"); 
             
            // Vaihe 5: Suoritetaan kysely, tulokset tallentuvat  
            // ResultSet-muuttujaan 
            ResultSet rs = s.executeQuery(); 
             
            // Vaihe 6: Käydään kaikki kyselyn palauttamat rivit 
            // läpi ja tulostetaan rivien sisältö ruudulle 
            while (rs.next()) { 
                System.out.println("Rekisterinumero: " + 
rs.getString(1) +  
                        ", malli: " + rs.getString(2)); 
            } 
             
            // Vaihe 7: Suljetaan lopuksi yhteydet 
            rs.close(); 
            conn.close(); 
             
        } catch (Exception e) { 
            e.printStackTrace(); 
        } 
         
    } 
     
} 
 

 
 

Kun koodi on valmis, tallenna Main.java-tiedosto painamalla Ctrl-s. 
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Vaihe 3: Testataan ohjelma 
Kun sovellus on luotu, on sen testaaminen suhteellisen helppoa. Valitaan hiiren oikealla 
painikkeella Main.java –luokan kohdalla aukeavasta valikosta Run File: 

 
 

Tämän jälkeen Netbeansin alalaitaan tulee näkyville ohjelman tuottama tuloste, tässä 
tapauksessa tietokannasta löytyneet tiedot: 

 
 

Sovellus on nyt valmis! 
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LISÄÄ AIHEESTA 
Java-ohjelmointia käydään läpi perusteista lähtien Pedacoden verkkokursseilla. Kursseilla 
käydään läpi sekä teoriaa että hyväksi havaittuja käytäntöjä, mutta erityisesti kurssit 
perustuvat itse tekemiseen ja oikeaan ohjelmointiin. 

Tietokantaohjelmointia käsitellään Pedacoden ”JDBC-ohjelmointi” –kurssilla. Kurssilla 
käydään läpi perusteista lähtien JDBC-teknologiaa sekä kerrataan myös lyhyesti SQL-
kielen syntaksia. Lisätietoja kurssista: 
http://www.pedacode.net/koulutuskalenteri_jdbc_ohjelmointi.html  

 
Pedacode tarjoaa myös suuren joukon muita Java-ohjelmointiin liittyviä kursseja. 
Kurssivalikoimaamme kuuluu mm. J2EE-ohjelmointiin, XML-kieleen ja Web Services –
ohjelmointiin liittyviä kursseja. Kurssitarjontamme kokonaisuudessaan löytyy osoitteesta 

http://www.pedacode.net/koulutuskalenteri.html 
 

Tervetuloa opiskelemaan! 
 

 
 

 
 

 
 

 
 

 

Oliko opas mielestäsi hyödyllinen? 
Jos tämä opas oli mielestäsi hyödyllinen, voit vapaasti kopioida ja levittää opasta 
tutuillesi tai laittaa sen jakoon yrityksesi tai muun työorganisaatiosi sisällä. Opas on 
kuitenkin aina jaeltava täydellisenä ja muuttumattomana kokonaisuutena. Oppaasta ei saa 
poistaa sivuja, eikä oppaan sisältöä saa muuttaa.  
Otamme myös mielellämme vastaan palautetta oppaasta, voit ottaa meihin yhteyttä 
sähköpostitse osoitteessa  asiakaspalvelu@pedacode.net  


